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STAMS® Interactive Whiteboard (IWB) Lessons enhance instruction by 
transforming lessons into engaging visual experiences. STAMS IWB Lessons are 
available for each lesson in the STAMS series student books. They offer students 
opportunities to question and explore mathematical concepts in greater depth. 

Accessing STAMS IWB Lessons
STAMS IWB Lessons were created to run in a software program called 
ActivInspire™. The program presents a wide variety of tools that you can use  
to enhance and annotate the lessons. This user guide discusses some of the key 
tools available to you but does not offer detail about every ActivInspire tool. 
Refer to the ActivInspire Help system for details about the tools not mentioned 
in this guide.

STAMS IWB Lessons can also run in ActivStudio™, the forerunner of ActivInspire. 
Both ActivStudio and ActivInspire were developed by Promethean Limited. The 
files are compatible with a variety of hardware, including SMART™ boards and 
Mimio® boards. 

Integrating STAMS IWB Lessons 
with the Print Series
STAMS IWB Lessons can be used to teach new lessons or review previous lessons 
from any STAMS level. For example:
•	 Use the IWB lesson in conjunction with Part One and Part Two of each 

print lesson. 
•	 Recap Part One and Part Two before moving on to Part Three and 

Part Four of the print lesson. 
•	 Review content of a previous lesson from any level before beginning 

instruction on a new lesson. 

Welcome to STAMS® Interactive Whiteboard Lessons
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Begin by moving through Part One of each STAMS IWB Lesson in order—
Explore, Think, Connect, Let’s Talk, Think It Through, and Your Turn. 
When you complete Your Turn in Part One, begin Part Two, moving through 
the pages in the same order. This is the order of Part One and Part Two of the 
print lesson. Have students follow along in their books so they will know where 
to find explanations and examples they may need to review later.

You can refer back to Part One and Part Two of each STAMS IWB Lesson when 
you work with other parts of the print lesson. And, of course, you can use the 
STAMS IWB Lesson as a review lesson for another lesson or grade.

Getting to Know STAMS® IWB Lessons 
Regardless of which lesson you have open, each STAMS IWB Lesson uses a 
consistent structure for identical lesson components in the print series.

Focus Questions
Each STAMS IWB Lesson presents a Focus Question on the Notes page for 
Explore. Use the question to frame the lesson and set a purpose for learning. 
The question not only identifies the core concept of the lesson, but gets students 
thinking about the answer arrived at through Explore, Think, and Connect. 

Explore 
Use Explore to engage your students, activating their prior knowledge of the 
concept introduced. Encourage them to share their knowledge and check to see 
that they have the proper tools to succeed. For example, be sure to review 
prerequisite concepts and vocabulary essential to understanding the lesson. 

Time and Pacing
Spend 2 to 3 minutes discussing the Explore information. 
The time will vary depending on the depth of students’ prior 
knowledge, the number of vocabulary terms, and students’ 
familiarity with the terms.

Using STAMS® IWB Lesson Content

STAMS® IWB User Guide



Think 
Think presents step-by-step interactive content to guide students’ thinking about 
new concepts and skills. Pull-down screens offer an additional method for 
ensuring students stay focused, and write-on lines allow students to input answers 
and compare them to the answers supplied in their books. Be sure to discuss with 
students how they arrived at each answer.

Remind students that material from the STAMS® IWB Lesson appears in their 
books too. When you make notes or highlight elements on the page, encourage 
students to do the same in their books. Student notes become an additional 
reference for independent learning. 

Time and Pacing
Work deliberately through the steps in Think, pausing to be sure 
students understand why the questions or statements are 
completed as they are. Depending on the number of steps and 
amount of new vocabulary, this will take 5 to 7 minutes. This is 
the section where understanding is developed, so take time to 
manipulate and discuss the visuals so that all students are 
comfortable with the material before moving on.

Connect 
Connect presents the core content of the lesson, answering the Focus Question. 
Use the interactive features of Connect to reinforce key concepts and skills.

Time and Pacing
Be sure to discuss this section in depth with students. Ask 
questions to check students’ understanding. Interact with the 
onscreen features to provide a variety of examples. Expect to 
spend about 5 to 6 minutes in Connect.

Let’s Talk 
Use Let’s Talk to get students thinking more deeply about what they have just 
learned and communicating their understanding to their peers. You can add a blank 
page to record the discussion or copy the original page so small groups of students 
can interact with it separately and present their ideas to the class. Be sure to save 
student work by selecting Save As from the STAMS IWB Lesson File menu. 

Time and Pacing
You’ll discuss some Let’s Talk questions longer than others. 
Allow more time for open-ended discussions. Allow students to 
discuss questions in pairs and to use the IWB to explain their 
thinking. As necessary, record student responses. Let’s Talk pages 
will take about 4 to 6 minutes.  

STAMS® IWB User Guide 5



Think It Through and Your Turn
Think It Through and Your Turn in each STAMS® IWB Lesson present 
problems and supporting information identical to the correlated sections of the 
Student Book page. Use the space on the right to write notes to show how to 
reason through the problems.

The Teacher Guide provides answers for the Think It Through and Your Turn 
problems. 

Think It Through 
Think It Through keeps students engaged in problem solving. Encourage 
students to write in their books as the class works through and records each step 
of the solution on the IWB. Use the STAMS IWB Lesson tools to interact with 
the Think It Through pages. See the Teacher Guide for answers.

Time and Pacing
Walk through the solution step-by-step as a class, using the IWB 
to illustrate examples, record calculations, draw diagrams, and  
so on. This should take approximately 5 to 6 minutes.

Your Turn 
Your Turn offers an opportunity for students to work alone or in pairs, while 
referring to their books. Students can share their solutions on the STAMS IWB 
Lesson page and discuss their work. Be sure to use errors as opportunities for 
learning. See the Teacher Guide for answers.

Again, you can add a blank page or copy the original page so small groups of 
students can interact separately. Be sure to save student work by selecting Save As 
from the STAMS IWB Lesson File menu. 

Time and Pacing
Allow time for students to solve the problem. The time will vary 
depending on the number of steps and computations involved. 
Generally, you can plan on 2 to 3 minutes. Then spend 3 to 
4 minutes discussing the correct answer. Use white space on the 
page and, if necessary, return to previous pages to help struggling 
students apply the instruction to the Your Turn problem. 
Consider copying an existing page and marking the diagrams or 
tables with the information in the Your Turn problem.

6STAMS® IWB User Guide



Teacher Tips!  
Making the Most of STAMS IWB Lessons

Be Prepared!
•	 Be sure to review lessons before you present them to the class. You’ll feel 

more comfortable with content that you’re familiar with and you’ll be 
ready to use the interactive features. 

•	 Review the Teacher Notes so you know the page features for the lessons.
•	 Deactivate the screen saver on the computer you are using to present the 

STAMS® IWB Lesson.

Personalize the Lessons 
•	 Adjust the lessons so they have more personal meaning for your students. 

For example, you can change the pets in a chart so they reflect pets the 
students know.

•	 Extend the lesson to answer questions and give more practice. Change or 
add more equations to a slide. Or, use the shapes in the Main Toolbox to 
extend a geometry lesson.

•	 Duplicate a slide so you can adjust content but retain the original slide. 
•	 Use the Pen, Highlighter, or other tools to emphasize page elements. 

You can even use the Zoom In feature to take a closer look at something. 

Class Participation
•	 Invite your students to complete activities at the IWB.
•	 Have students work at their seats, then come to the IWB to show how 

they solved a problem.
•	 Have students work in groups. Then invite a representative to come to the 

IWB to show their work. 
•	 Have students create a presentation on the IWB to teach something to 

their classmates. 
•	 If you use response devices, gather class feedback. If you don’t have 

response devices, you can use slates or a show of hands. 

Save Your Presentations
•	 You can save your presentation as a flipchart or PDF and post it to your 

class web site where students can access it for further study.
•	 If a screen recorder is available, use it to capture the onscreen activities. 

Consider using a microphone, too.
•	 Open a lesson before you teach it and make any adjustments needed for 

your class. For example, you might want to add extra skills practice.

STAMS® IWB User Guide 7
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STAMS® IWB Lessons offer intuitive tools for 
working on the lesson pages. Lessons use a 
standard layout and a consistent structure, so you 
can focus on the lesson content and your students.

Lessons are color-coded to coordinate  
with the color-coded levels in the STAMS print 
series.

The Home Page
The Home page offers a consistent layout. 

A 	� An IWB lesson includes each section of 
Part One and Part Two in the Student 
Book. Click a button to open the STAMS 
IWB Lesson section.

B 	� There is one file for each STAMS lesson in a 
level. STAMS IWB Lessons show the lesson 
number and name as well as the STAMS 
book and coordinating color.

Getting to Know the STAMS IWB Lesson Interface

STAMS® IWB Lesson Interface

A

B

B



STAMS® IWB User Guide 9

Navigating Lesson Pages
Because lessons always flow across several 

interactive pages, STAMS® IWB Lessons present 
tools for navigating the pages.

A 	� Click the Back or Next button to move 
back or forward in the lesson, one page at 
a time. 

B 	� The current STAMS IWB Lesson section 
name is highlighted when it is active. You 
can click another section name to open a 
different section.

C 	� Some sections have multiple pages. Click a 
page number to move directly to that page 
in the lesson.

D 	� Click the Home icon to return to the Home 
page where the lesson content  
is displayed.

E 	� Click the Reset icon to undo changes you’ve 
made to the page. The current page reverts 
to the original settings. The Reset feature 
changes only the current page. See “Lesson 
Tools and Features” for more information. 

F 	� Click the Notes icon to see information 
about how to use the current page. See 
“Teaching with the Lessons” for more 
information.

A
B

C

D E F
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STAMS® IWB Lessons make use of valuable 
interactive elements to engage students in learning 
and to enhance the instructional experience. The 
tools available on each page vary, depending on 
the page content.

This user guide does not describe all on-page 
elements. Rather, it describes prominent features 
that will likely lead you to discover additional 
interactive features. Remember, STAMS IWB 
Lessons are filled with interactive opportunities. 
We encourage you to explore the pages to 
discover the best way to use them in your 
classroom. Click the Notes icon on lesson pages 
for tips on some of the interactive features that are 
available.

A 	 Notes

Notes offer you valuable insight into how to 
use the current page. Because they are derived 
directly from STAMS Teacher Guide content, you 
won’t need to go back and forth between the 
book and a STAMS IWB Lesson. The Notes differ 
depending on the page from which you open 
them. They may identify the functionality available 
on the page, provide answers (in red) to questions 
on the student page, offer extension questions and 
answers, or provide reinforcement tips or ELL 
support.

You can add your own information to any of 
the Notes pages. Simply click the Notes icon and 
select the Text tool  in the Main Toolbox. Then 
type your own notes in the section. Be sure to 
preserve your changes by selecting Save As from 
the File menu.

Teaching with the Lessons

A

A
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Print 
Print a copy of the Notes in advance so you 

have them on hand when you go through the 
STAMS® IWB Lesson pages in the classroom. 
Select Print from the File menu. Then check the 
Include page notes box and the Print notes 
only box and click Print.

Pin
You can pin the Notes so they stay open, even 

when you move to another page. Click the pin  
in the upper right corner of the Notes section. 
When the pushpin appears with a highlight, the 
Notes section remains open. Click the pin again to 
hide the Notes section. Click the x button to 
close the Notes section.

B 	 Popup Vocabulary Words

Many lessons include vocabulary terms—the 
same terms that are included in the Student Book. 
These vocabulary terms appear with yellow 
shading, or highlighting, around them. Click a 
highlighted word to open the definition. Click the 
Close button in the definition box to close the 
definition.

C 	 Pull Tabs

Pull tabs allow you to move information on and 
off the page. When you drag the pull-tab arrow 
on to the page, additional information appears. 
For example, the pull tab might provide the data 
needed to solve a problem,  
a formula, or the solution to a problem.

Drag the information anywhere on the page, or 
close the pull tab by dragging it off the page.

A 	 Using the Pen

BC
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STAMS® IWB Lessons include areas where you 
or students can enter solutions. Click the Pen tool 
in the Main Toolbox to fill in answers.

If you want to change the solutions, click Reset 
or click the Eraser tool in the Main Toolbox. See 
“Lesson Tools and Features” for more information.

B 	 Clonable Art  

STAMS IWB Lessons allow you to clone many 
of the art elements. Clonable art is easy to identify. 
Simply move your cursor over an element. If the 
cursor changes to a hand with a plus sign in a green 
circle , you can clone the art. Each time you 
click a clonable element, you create a copy of the 
element. Drag the cloned element anywhere on the 
page.

C 	 Shifting Objects on a Page

You can move many of the objects on STAMS 
IWB Lesson pages. Simply select the object, in 
this case a basketball , and drag it to a new 
location on the page. Use drag and drop to 
deepen student understanding of pictographs and 
to examine the relationships among objects.

In most cases, STAMS IWB Lessons are 
designed so you can shift and manipulate the 
elements to meet your needs. For example, you 
can shift the height of bars in a graph, move 
counters from one side of the page to the other, 
or move elements on a single page. 

Remember, the Notes section always gives you 
tips for working in the current lesson.

A

B

C
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A 	 Click-Through Boxes

Click-Through boxes allow you to move 
through a set of numbers one at a time. They 
provide a simple way to practice a skill using a 
variety of numbers. When you see a shaded box, 
click it to change the number in the box. 
Continue to click the box to cycle through the 
available numbers.

B 	 Blank Lines

A blank line indicates that you can use the Pen 
tool to fill in an answer. The Pen tool is available 
from the Main Toolbox. See “Lesson Tools and 
Features” for more information.

B

A

B
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A 	 Manipulating Shape Models

STAMS® IWB Lessons offer several types 
of models that you can manipulate to enhance the 
lesson.  

For example, you can reshape or rotate  
a geometric figure, shift the rays in an angle 
diagram, and even drag shapes onto the page. 
Remember to refer to the Notes for details about 
the options available for manipulating models on 
the current page.

Before you begin a lesson, review the onscreen 
shape models to familiarize yourself with the 
actions you can perform. 

A
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A 	 Sliding Screens

STAMS® IWB Lessons offer sliding screens to 
temporarily cover some of the page content. Pull 
the bar of the sliding screen down to reveal 
content gradually. Sliding screens allow you to 
customize the pace of your lesson to 
accommodate student needs and provide a simple 
tool for engaging students one line at a time. 
Drag the arrows up to hide the content.

B 	 Manipulating Graphics

STAMS IWB Lessons make use of several types 
of models that you can manipulate to enhance the 
lesson. Refer to the Notes for details about the 
options available for manipulating models on the 
current page.

A

B
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Lesson Tools and Features
The Main Toolbox and the menus in ActivInspire™ present several tools you 

can use to enhance or edit the STAMS® IWB Lesson pages. This section describes 
several of the more commonly used tools. Explore  
the toolbox and menus to discover additional features. Open the ActivInspire™ 
Help system from the Help menu to learn more  
about any of the features. 

Zooming In and Out 
You can enlarge or shrink a STAMS IWB Lesson page or you can 

zoom in or zoom out of a specific region.  

To magnify a region, press Ctrl + Shift + Z. When the magnifying 
glass icon appears , click the page; then press and hold the cursor. 
To zoom out, right-click the page, and press and hold the cursor.

You can also select a magnification setting from the list at the upper right of 
the page. Open the list and select a page magnification level or  
a general level such as Fit to Width. 

Using the Pen/Highlighter 
If you prefer a pen color other than black, select a color from the color palette. 

Then click the Pen tool and drag the cursor to write or draw on the STAMS IWB 
Lesson page.

The Highlighter tool works in much the same way. Select a highlight color 
from the color palette and click the Highlighter tool. Then drag the cursor to 
create a highlighted line or shape. 

Use the Pen Width tools to change the size of the pen or highlighter stroke.

Eraser  
You can erase any element that you’ve added to the STAMS IWB Lesson page. 

Click the Eraser tool in the Main Toolbox and move it over the area on the page 
you would like to remove. Use the Pen Width tools to change the size of the 
eraser.

You cannot erase elements that are included in the original STAMS IWB 
Lesson pages.
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Copy a Page 
It’s very likely that you’ll want to duplicate  

an existing page and use it as the foundation  
for a new page. The Copy feature allows you  
to select a page to copy and to create as many  
duplicates as necessary. You can copy pages  
from the Page Browser.

Select Browsers from the View menu and 
open the Page Browser. Scroll through the  
thumbnail pages and select the page you  
would like to copy. Then right-click the page  
and select Copy from the popup menu.

In the Page Browser, right-click the  
thumbnail page directly before where you  
want to insert the copied page. Select Paste 
from the popup menu.

You can copy and paste more than one page  
at a time. Open the Help system from the  
Help menu to learn more about the Copy and  
Paste features.

Save Page Changes
Because the customizations and annotations you and your students add to 

STAMS® IWB Lessons are very valuable, you can preserve them with the Save 
As command. Save As, available from the File menu, allows you to save your 
changes to a new lesson while retaining a copy of the original lesson. When you 
use Save As, supply a name for the new lesson and specify a location to store it.

Print the Pages or Export to PDF
You can print any open STAMS IWB Lesson or export it to PDF format. Select 

Print from the File menu and specify settings in the print box that opens. Be 
sure to select Include page notes if you’d like to include the Notes section in 
the print or PDF file.

Reset the Page
Even though STAMS IWB Lesson pages are meant to be annotated and 

customized, you might want to reset the pages so they revert to the original 
settings. When you click the Reset button, your changes are cleared and the page 
returns to its original state as long as you haven’t saved changes.

If you want to preserve changes you’ve made to a lesson, be sure to use the 
Save As command before you click the Reset button.

A Reset button is available on each lesson page as well as on the toolbar. 


